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Scopo di questo documento

Questo documento non pud in alcun modo sostituire la documentazione esistente
della tua Radioddity GD-73, ma & pensato per guidarti ad andare ‘in onda’ e iniziare a
trasmettere per la prima volta. Pertanto, questo documento descrive solamente i
passaggi fondamentali e necessari per metterti ‘in onda’. Per fare cid, segui
attentamente i successivi passaggi:

~N O

Fai la richiesta per ricevere il tuo ID DMR
Ricerca informazioni riguardo la/e stazione/i che desideri utilizzare con la tua radio (es.
ripetitori)
Installa i driver USB
Installa il CPS
Crea un nuovo CodePlug partendo da zero
a. Inserisci il tuo CallSign e il tuo ID DMR
b. Crea | tuoi Contatti Digitali / TalkGroups (TG)
c. Imposta il tuo Elenco di Gruppi RX Digitali
d. Programma i tuoi Canali, assegna un Contatto Digitale per il TX e
assegna un Elenco di Gruppi RX Digitali ad ogni Canale
e. Programma la tua Zona, assegnando dei Canali ad ogni Zona

. Salva il tuo CodePlug e copialo sulla tua radio
. Vai ‘in onda’ con il tuo CodePlug appena creato

1. Richiedere un ID DMR

Per utilizzare una rete DMR & necessario registrarsi per la richiesta di un ID DMR. In
ambito radioamatoriale, questo pud essere richiesto su https://www.radioid.net/
oppure https://register.ham-digital.org/, a seconda di dove vivi. Solitamente i nuovi ID
DMR verranno emessi entro 24 ore dalla richiesta.

2. Cercare informazioni sulle stazioni DMR nelle vicinanze

Ci sono varie fonti da cui ottenere i dettagli richiesti per la programmazione di un
canale per utilizzare una specifica stazione o rete DMR, tra cui:

https://brandmeister.network/

http://www.dmr-marc.net/repeaters.html

oppure mettiti semplicemente in contatto con il club o associazione radioamatoriale
piu vicini a te.

Pagina 4 di 22


https://www.radioid.net
https://register.ham-digital.org/
https://brandmeister.network/
https://brandmeister.network/
http://www.dmr-marc.net/repeaters.html
http://www.dmr-marc.net/repeaters.html

Andare ‘in onda’ con la tua Radioddity GD-73 v1.0

Controlli Radio

Headphone Jack

Antenna

Flashlight

status LED

SP
MIC

UsSE
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PTT Vol+
Flashlight Key Vol—
On/Off

Generale

Accendere la radio

Il pulsante di accensione/spegnimento &€ posto sul lato destro della radio. Tieni
premuto il tasto per circa 3 secondi per accendere la radio. Apparira il logo
Radioddity sullo schermo, il LED di notifica si illuminera brevemente di rosso e la
radio emettera un breve sequenza di 4 toni.

Spegnere la radio
Tieni premuto il tasto di accensione/spegnimento per circa 3 secondi per spegnere la
radio. Il display si spegnera.

Regolare il volume

Al di sopra del pulsante di accensione/spegnimento ci sono i pulsanti per il Volume +
(M) e per il Volume - (§). Utilizza questi pulsanti per regolare il volume dello speaker
integrato o di qualunque speaker o auricolare esterni.

Note:
Proseguendo all'interno di questo documento, i simboli B8 e B@ si riferiranno a
selettori Su/Giu posti sul pannello frontale della GD-73, al di sotto del display LCD.
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Programmare la GD-73

La GD-73 € una radio UHF con DMR (True Tier | e Tier Il), oltre all’analogico FM.
Offre un totale di 1024 Canali (sia analogici che digitali) sistemati fino ad un massimo
di 64 Zone. Ogni Zona pud accomodare un massimo di 16 canali. In aggiunta, &
possibile salvare un massimo di 1024 contatti, sempre tramite CPS.

Il file creato dal Software di Programmazione da Computer (CPS) contiene le
frequenze e gli altri parametri operativi per la radio, e viene definito ‘CodePlug’.
Creare un CodePlug € un processo che richiede prima di tutto la creazione degli
elementi comuni, che verranno poi combinati per formare un CodePlug che verra
copiato sulla radio. Con il CPS della GD-73 potrai creare in autonomia il CodePlug
che soddisfi esattamente tutti i tuoi requisiti, oppure potrai usare il CodePlug di
qualcun altro, se cosi desideri. Non dimenticare di salvare il tuo CodePlug una volta
conclusa la programmazione, cosi potrai facilmente effettuare modifiche in futuro alla
configurazione della tua radio.

Il cavo di programmazione della GD-73 & un accessorio incluso nella confezione. I
cavo di programmazione ha da una parte un connettore USB di Tipo A, da inserire in
una porta USB del PC, e dall’altra un connettore Micro USB, per il collegamento con
la radio GD-73. Questo cavo & un semplice cavo Micro USB standard, lo stesso tipo
che utilizzano molti smartphone. Il cavo non contiene nessuna elettronica o chip
specifici. Affinché la radio GD-73 possa essere identificata dal PC, essa deve essere
collegata al PC tramite questo cavo e la radio deve essere accesa.

Note

Non c’é nessun chip o elettronica particolare all’interno del cavo di programmazione
quindi la porta di comunicazione della radio puo essere identificata solo quando Ig
radio € accesa.

3. Installare i driver USB

1. Individua il file chiamato ‘usblib_hrc7000.exe’ nella cartella del software.

' usblib_hrc7000.exe

2. Avvia questo programma come Amministratore.

3. Se possibile, non salvare il driver .inf appena generato sulla Scrivania o
Desktop del computer, ma in una directory differente del disco di avvio del PC.

4. Successivamente partira automaticamente il processo di installazione del
driver.
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Installing Driver...

5. Attendi il completamento dell’installazione.

The installation process can take up to 5 minutes...

6. Una volta completata con successo l'installazione, vedrai un messaggio che
riporta lo stato di successo dell’installazione.

Installation successful

K

Bl

In caso di errore, interrompi l'installazione e prova a ripetere linstallazione un’altra
volta, salvando il file ‘walkie-talkie-C7000.inf’ e gli altri file in una posizione diversa
sul disco.

Usa Windows Device Manager per verificare che il computer abbia caricato il driver
appropriato per il dispositivo. Non saranno richieste ulteriori configurazioni del driver.

oy

Se il driver non dovesse caricasi automaticamente, puoi scaricare manualmente i
driver corretti per sistemi 32-bit e 64-bit dal sito https://www.radioddity.com.

CPS e aggiornamento del firmware fornito da Radioddity

Il Software di Programmazione da Computer (CPS) per la GD-73 & aggiornato da
Radioddity quando vengono aggiunte nuove funzionalita, quando bug noti vengono
sistemati o vengono effettuate altre migliorie. Per aggiornamenti, visita il sito
Radioddity: https://www.radioddity.com.
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Note
La versione del software dovrebbe sempre rispecchiare la versione del firmware. Per
fare un esempio, la versione del software v1.00 dovrebbe sempre essere usata con
la versione del firmware v1.00, ecc. Questo firmware e specifico a questo modello
Caricando un firmware di un altro modello di radio non si aggiungeranno ulterior|
funzionalita alla radio GD-73, anzi, molto probabilmente si rendera la radig
inutilizzabile.

4. Installare il CPS

Prima di poter iniziare a programmare il tuo CodePlug usando il CPS fornito da
Radioddity devi installare i driver USB, come descritto nel capitolo precedente, ed il
CPS, come descritto in questo capitolo.

1. Individua, all'interno della cartella del software, l'installer per il tuo CPS, che
potrebbe essere chiamato ‘GD-73_CPS_v1.00.exe’.

i5) GD-73_CPS_v1.00.exe

2. Avvia questo programma come Amministratore.

5

Select Destination Location
Where should GD-73 be installed?

Setup will install GD-73 into the following folder.

o continue, dick Next, If you would like to select a different folder, dick Browse.,

C:\Program Files (x86)\GD-73 Browse...

At least 6,0 MB of free disk space is required.

=

Ty — .

3. |l percorso in cui verra installato il CPS pud essere cambiato (2) prima di
cliccare sul pulsante ‘Next >’ (3), per proseguire con l'installazione del CPS.
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|81 setup - 6D-7: z

Select Start Menu Folder
\Where should Setup place the program's shortouts?

.'J’_'
|J Setup will create the program's shortcuts in the following Start Menu folder.
[ e

To continue, dids Mext. If you would like to select a different folder, dick Browse. P

IGD—?3 [ Browse...

[ ]Don't create a Start Menu folder

3
< Back Cancel
w L) m -

4. Se desideri cambiare il nome della cartella (1) o non vuoi che linstaller crei
una cartella nel menu di avvio (2), sei libero di cambiare queste impostazioni
prima di proseguire con I'installazione, premendo il tasto ‘Next >’ (3).

Select Additional Tasks
| Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while instaling GD-73, then
dick Mext.

Additional shortcuts:
Create a desktop shortout

> pp—

5. Si consiglia di spuntare la casella per creare un collegamento sul Desktop
prima di proseguire con il pulsante ‘Next >’.
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i

Ready to Install
Setup is now ready to begin installing GD-73 an your computer,

Click Install to continue with the installation, or didk Badk if you want to review ar
change any settings,

Destination location:
C:\Program Files (x88)\GD-73

Start Menu folder:
GD-73

Additional tasks:
Additional shortcuts:

Create a desktop shortcut
< Back Install Cancel
5 - = L

6. L'ultimo click sul pulsante ‘Install’ dara il consenso per installare il CPS con le
impostazioni che sono state fornite.

i

Completing the GD-73 Setup
Wizard

Setup has finished installing GD-73 on your computer, The
application may be launched by selecting the installed
shortcuts,

Click Finish to exit Setup.

Launch GD-73

7. Dopo pochi secondi il processo d’installazione sara completato e premendo il
pulsante ‘Finish’ verra aperto direttamente il CPS.
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5. Creare un CodePlug partendo da zero

Per iniziare a creare un CodePlug per la tua GD-73, prima premi sull’opzione ‘Read
Data’ per scaricare i dati dalla radio al PC per avere un primo template di CodePlug
da modificare successivamente e per avere un backup di fabbrica per utilizzi futuri.
Per leggere o scrivere i dati dalla o sulla GD-73, il software presenta alcune opzioni
tra cui scegliere:

Program = Settings  View Windo,
: Read Data Ctrl+R b
Write Data  Ctrl+W

Developer Mode

Read Data«(lteggi i dati)

Per leggere e scaricare tutte le frequenze e le impostazioni della tua GD-73,
seleziona quest’'opzione.

Write Data (Scrivi i dati)

Una volta completate le modifiche alle impostazioni della tua GD-73, seleziona
quest’opzione per copiare e caricare il tuo nuovo CodePlug sulla radio.

Note
Si consiglia vivamente di creare un CodePlug da zero, piuttosto che utilizzare i
CodePlug di qualcun altro.

4a. Inserire i propri CallSign e ID DMR nel CodePlug
Per salvare il tuo ID DMR personale allinterno del CodePlug, clicca su
‘Edit'>‘General Settings’

F adio Mame 1Ihr Stationzname

Fladio IO |1 2345678

T—

Note

Non operare mai la radio con un ID DMR che non ti € stato assegnato. Nelle ret
radioamatoriali, questo puo comportare I'annullamento e la perdita della proprig
licenza radioamatoriale.
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4b. Creare Contatti Digitali
Possono essere salvati un massimo di 1024 Contatti Digitali. Questi Contatti Digitali

sono usati per salvare

i TalkGroups (TG), oltre alle stazioni individuali con il proprio

ID DMR. Seleziona ‘Edit’'=> ‘Digital Contacts’ per modificare i Contatti Digitali.

i [Sle =]

Mo. |Call Name Call Type Call D

1 Ww Group Call b

2 DL262 Group Call 262

3 DL263 Group Call 263 .

4 TG910-German Group Call 910

5 DL-OE-HBS Group Call 920 V

] WW maritime Group Call 9101 -

7 EmCom EU Group Call 112

8 TG Group Call 91

9 MNRW Group Call 2624

10 regional Group Call 8

11 |parrot Private Call 262007

€ > -
T e Oy
No. (Numero) Numero nella lista dei Contatti Digitali (fino a 1024)
Call Name (Nome) | Il nome che verra mostrato per quel Contatto
Call Type (Tipo di E possibile scegliere tra i seguenti tipi di chiamata:
Chiamata) «  Group Call (Chiamata di Gruppo)
* Private Call (Chiamata Privata o Singola)
» All Call (Chiamata Generale)

Call ID (ID della L'ID di un individuo (chiamata digitale privata) o di un
Chiamata) TalkGroup (TG). Questo ID funge da identificativo e per

comunicare con la radio a cui & destinata la chiamata (ID
DMR) oppure con un gruppo di radio (TG), in base al tipo di
chiamata selezionata precedentemente.

Call Receive Tone
(Tono di Ricezione
per la Chiamata)

Verra eseguito un suono di avviso sulla radio ricevente prima
di mutarsi durante una Group Call, Private Call o All Call.
Questa funzione € impostata in base alle esigenze di ogni
chiamata.

4c Impostare i Gruppi RX Digitali (Digital RX Groups)
Ogni Canale Digitale puo ricevere uno o piu TalkGroups. | TalkGroups che si vogliono
ascoltare devono essere definiti in un Gruppo RX Digitale (Digital RX Group) e

assegnati ad un canale.
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Creare un Gruppo RX Digitale ti permette di raggruppare i tuoi TalkGroups (TG)
digitali in gruppi logici, affinché possano essere successivamente indirizzati
all'interno delle impostazioni del canale.

« E possibile creare e nominare un massimo di 250 Gruppi RX Digitali
individuali, per identificare ogni gruppo.
+ Ogni gruppo pud contenere il minore o il massimo numero di contatti che

desideri.

» Ai gruppi bisognerebbe assegnare un nome che abbia un certo significato per
utente.

« Solo i contatti salvati come Group Calls possono essere aggiunti all’interno di
un Gruppo.

* Ogni canale digitale (DMR) deve avere un Gruppo RX Digitale, con almeno
un contatto del TalkGroup TX per il canale, oppure un membro del gruppo che
hai assegnato al canale.

» Se non viene associato un Elenco di Gruppi RX Digitali ad un Canale DMR,
non sarai in grado di ricevere o ascoltare nulla su quel canale.

Per modificare questi gruppi, clicca ‘Edit’ > ‘Digital RX Group List’. Un tipico Gruppo
potrebbe assomigliare al seguente:

Fi# Group List Mame |T51

Available Members
MW W
reqgianal DL2E2
DL2E3
TGH10-German
DL-0E-HES

“WwWhad maritime
EmCom ELI

Add
Bemove TG

10f2 | | o> | o1 | add | Delete |

Cliccando sul pulsante ‘Add’, potrai aggiungere un altro Gruppo RX Digitale.
Cliccando sul pulsante ‘Delete’, eliminerai il Gruppo RX Digitale selezionato.
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Note

Per iniziare, conviene raggruppare tutti i Contatti Digitali (TG) attivi sul TimeSlot 1
all’interno di un gruppo e chiamarlo ‘TS1’. Per quelli attivi sul TimeSlot 2, invece
imposta il nome del gruppo corrispondente su ‘TS2’.

4d Creare i Canali

Per creare dei canali, clicca su ‘Edit = ‘Channel Information’. Successivamente,
potrai selezionare uno dei canali preesistenti. Nel scegliere | nome, inserisci
allinterno anche le informazioni sul TalkGroup (TG), dal momento che potrebbe
tornare utile durante ['utilizzo della radio. Ad es.: <posizione geografica della
stazione/ripetitore>-<TG>; un esempio potrebbe essere: ‘Colonia-262'.

File Edit Program Settings View Window

O «d+ ?

Help

‘x

5l Digit Radio

----- | Base Information
----- 7% General Settings

§ Alert Tone

{0 Buttons
{5 Quick Text
4 Encrypt

Digit Emergency System

----- % Digital Contact
- Digital RX Group List
L8 TS
L Ts2
G- Zone
E:) Scan List
e
-8 pi*-263
@8 ACH 1

8 pit-parrot
-4 OHL-parrot

4 pi*-DL262

8 CH 1
&8 pi-910
- pi*-911

) pir-91
- OHL-263
-8 OHL-910
DMR Services
DTME Signaling
~{RE DTMF System
~[F DTMF Code
& PTT Template

Digital/&nalog

Mode [gal =]
Channel Space [12.5€ -

Power Level [High

Ccess Polty | Alwaps Gk
PTT Template |Mone

- Analog

Tx CTCSS/CDCSS |Mone

CTCSS Ene [570
CDCSS Ene [023

4af12

Channel Hame

OHL-262

438 862500

EncyiHz]

Copy

T Fraquency(MHz] [431.262500

Talk Around [
R Onlp [

Auta Start Sean [

RX CTCSS/COCSS

woX [

Mone

CTCSS Dee [G70
COCSS Deo [023

k- J << ] > | -

Digital

T¥Contact [DL2E2 =]
sG]
ColorCade [1 ~|
ReGouplit 181 <
Emegeney [Ware =]
Encrypt m

add | Delets |

Cliccando sul pulsante ‘Add’, potrai aggiungere un altro canale.
Ecco una breve spiegazione sui diversi campi che potrai personalizzare per ogni

canale:
Digital/Analog
Mode Scegli tra ‘analogico’ e ‘digitale’
Channel name Il nome del canale (esso deve essere unico)
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RX Frequency

La frequenza di ricezione in MHz

TX Frequency

La frequenza di trasmissione in MHz

Channel Space

Seleziona la larghezza di banda per la
trasmissione/ricezione. In modalita digitale, la larghezza &
fissa a 12.5kHz

Power Seleziona la potenza in uscita per le trasmissioni (la
potenza per i canali PMR446 non pud essere cambiata)

Scan List Seleziona quale lista scansionare quando viene attivata
la modalita di scansione

Talk Around Permette di scambiare le frequenze di trasmissione e

ricezione

Access Policy

Nota anche come ‘Admit Criteria’, esso permette di
selezionare la modalita di invio della trasmissione

RX Only

Imposta il canale in modalita di sola ricezione. La
trasmissione viene disattivata su quel canale

Auto Start Scan

Non appena il canale viene selezionato, la radio iniziera
automaticamente a scansionare la lista specificata nella
voce ‘Scan List’

PTT Template

Per i canali analogici, il PTT Template pu® essere
specificato qui.

VOX Seleziona se il VOX (Voice Activated Transmission) &
attivo per il canale
Digital
TX Contact TalkGroup (TG) assegnato a questo canale
Slot Seleziona quale intervallo di tempo, 1 o 2, deve essere
utilizzato. Spesso, un determinato TalkGroup viene
assegnato ad un determinato TimeSlot
Color Code Seleziona quale ColorCode (CC) & associato a questo
canale
RX Group List Questo determina I'Elenco di Gruppi RX utilizzati per il
canale
Emergency Definisce quale sistema di emergenza & pertinente per
questo canale
Encrypt Imposta il criptaggio sul canale corrente
Analog
TX CTCSS/DCS Scegli il tipo di tono subaudio da codificare durante la

trasmissione: ‘None’ ‘CTCSS’, ‘DCS’ o ‘DCS Invert’
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RX CTCSS/DCS Scegli il tipo di tono subaudio da decodificare durante la
ricezione: ‘None’ ‘CTCSS’, ‘DCS’ o ‘DCS Invert’

CTCSS Enc Se ¢ stato selezionato ‘CTCSS’ per la trasmissione, qui
€ possibile selezionare la corrispondente frequenza
subaudio da trasmettere

CTCSS Dec Se é stato selezionato ‘CTCSS’ per la ricezione, qui €
possibile selezionare la corrispondente frequenza
subaudio da ricevere

DCS Enc Se & stato selezionato DCS o DCS Invert per la
trasmissione, qui € possibile selezionare il corrispondente
codice DCS subaudio da trasmettere

DCS Dec Se & stato selezionato DCS o DCS Invert per la ricezione,
qui & possibile selezionare il corrispondente codice DCS
subaudio da ricevere

Una volta completato, clicca su ‘OK’ per salvare il canale.

Note:
E utile, ma non essenziale, che il nome del Canale DMR indichi quale TalkGroup TX
e assegnato al canale. La maggior parte dei campi verra precompilata con i valor
corretti. Per l'utilizzo del DMR sono principalmente i campi Mode, Channel Name
RX/TX Frequency, TX Contact, Slot, Color Code e RX Group List che devono essere
allineati alla stazione specifica che si desidera utilizzare.

4e. Raggruppare i Canali in Zone

Una zona € una raccolta o un gruppo di canali. Possono essere raggruppati in
qualsiasi modo tu voglia: ad esempio, una zona per ogni area geografica, 0 una zona
con TalkGroup diversi per un ripetitore, o qualsiasi altro modo che ritieni sia utile e
conveniente. Una volta definiti i canali, sei pronto per raggrupparli in zone per un uso
successivo. E possibile memorizzare fino a 16 Canali radio in una singola Zona della
tua GD-73. In totale, sono possibili fino a 64 zone. Ad esempio, ha senso
raggruppare i canali in base al loro uso. E ragionevole raggruppare tutti i canali di
ripetitori DMR in una zona. Un'altra zona potrebbe contenere tutti i canali radio
analogici di una regione geografica.
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B Zone [ [@ =]

Zone Mame |DBOOHL

Avvailable tembers

OHLAwM
OHL-DL
OHL-DLIMK) 3
OHL-German
DHL-DLOEHES Add ‘
OHL- W maritime =
OHL-Emeom EU
OHL-Ruhrgebiet
COHL-Parrat
Fa-Farrat 4
SR
F5-DL
P5-DL{MM]
P5-Calibrate
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1. Prima di tutto, dai alla Zona un nome significativo (1), come ad esempio il
nome del ripetitore di cui si desidera memorizzare i canali nella Zona.

2. Successivamente seleziona dalla lista dei Canali radio disponibili (2), sulla
sinistra, tutti quelli che vuoi raggruppare in quella Zona.

3. Clicca sul pulsante ‘Add’ (3) per aggiungere ogni singolo canale.

4. 1l canale appena aggiunto apparira nel riquadro di destra (4) sotto la dicitura
‘Members’.

Questo e tutto cid che & necessario.

6. Copiare il CodePlug sulla Radio

Dopo aver completato i passaggi precedenti, &€ prima consigliabile di salvare i dati sul
PC in modo locale (‘File’ > ‘Save’/’'Save as’) prima di tentare il trasferimento e la copia
dei dati dal PC alla tua GD-73. Per copiare il tuo nuovo CodePlug appena creato, clicca
su ‘Program’->‘Write Data’

File Edit Program Settings View Windo
[ O = E Read Data Ctrl+R

i Write Data  Ctrl+'W t.?
et
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7. Vai ‘in onda’ ed inizia a trasmettere

Adesso sei preparato per iniziare a trasmettere.

Selezionare una Zona
Una Zona € un raggruppamento di Canali radio. La tua radio & capace di contenere

un massimo di 64 Zone, ognuna contenente 16 Canali al massimo.

1. Premi il pulsante per entrare nel menu.

2. Utilizzando i pulsanti B8 ¢ B, naviga allinterno del menu e conferma la tua
selezione premendo nuovamente il tasto Y=\

3. Seleziona la voce ‘Settings’ nel menu.

Successivamente, seleziona la voce ‘Zone’ nel sotto-menu.

5. Utilizzando i pulsanti u e ﬂ naviga fino alla Zona desiderata e conferma la
selezione della tua Zona scelta premendo il pulsante [JIENV.

6. Il display adesso mostrera la Zona selezionata al centro dello schermo.

7. La linea al di sotto mostra il Canale selezionato al momento, appartenente alla
Zona selezionata.

s

Selezionare un Canale
Naviga tramite i pulsanti B§ e [ per selezionare il canale desiderato. In questo caso

non € necessaria la conferma tramite il pulsante [\JI=\19).

Ricevere e rispondere ad una Group Call DMR
Per poter ricevere una Chiamata di Gruppo DMR (DMR Group Call), bisogna prima
selezionare un gruppo (TalkGroup o TG) sulla radio. Ad ogni Canale DMR ¢& possibile
assegnare esattamente un gruppo utilizzando il CPS.

Ricevere una Group Call DMR
Per prima cosa, bisogna selezionare sulla radio un Canale a cui sia assegnato un
gruppo (TalkGroup o TG). Solo allora sara possibile ricevere una Chiamata di Gruppo.

1. Il LED di notifica si illuminera di verde
2. Se il Canale non ¢ attivo, il display mostrera:
+ nellariga al centro il nome della Zona
* nellariga in basso il nome del gruppo selezionato
3. Se il Canale diventa attivo, il display mostrera:
* nellariga di sopra il Gruppo
* nellariga al centro I''D DMR del contatto chiamante
* nella riga in basso la dicitura ‘Calling’, seguita da ‘End call’ se il canale non
era precedentemente attivo
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1. Mantieni la radio verticalmente, a circa 2,5-5cm di distanza dalla bocca

2. Premi il tasto PTT per rispondere alla chiamata. Il LED di notifica si illuminera di
rosso. Adesso potrai parlare

3. Una volta finito di parlare, lascia il tasto PTT per ritornare alla modalita di
ricezione

4. Se non si ascolta una risposta entro un tempo predeterminato, la chiamata &
terminata

Iniziare una Group Call DMR
Tutte le radio con cui desideri comunicare devono essere sullo stesso Gruppo.

1. Seleziona il Canale desiderato utilizzando i pulsanti ! e ﬂ La programmazione
dei nomi dei canali con un nome associato al TalkGroup €& utile per facilitare
l'utilizzo della radio. Mantieni la radio verticalmente, a circa 2,5-5cm di distanza
dalla bocca

2. Premi il tasto PTT per trasmettere. Il LED di notifica si illuminera di rosso. Il nome
del Gruppo apparira sul display

3. Una volta finito di parlare, rilascia il PTT per ritornare alla modalita di ricezione.
Se non si ascolta una risposta entro un tempo predeterminato, la chiamata &
terminata

4. Quando la chiamata viene risposta, vedrai il LED di notifica diventare verde.

5. Sul display vedrai:

* nella riga di sopra il Gruppo

* nellariga al centro I'ID DMR del contatto chiamante

* nella riga in basso la dicitura ‘Calling’, seguita da ‘End call’ se il canale non
era precedentemente attivo

6. Se la funzione Channel Free Indication Tone & attivata, udirai un breve tono
quando la trasmissione & terminata.

7. Quando la Group Call & terminata, il display ritornera alla schermata precedente.

8. Una Group Call pud anche essere iniziata dai contatti.
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Grazie per aver acquistato da Radioddity!

TUTORIALS, SUPPORTO TECNICO E MOLTO ALTRO
POSSONO ESSERE TROVATI SU:

g https://www.radioddity.com/ nhttps://www.facebook.com/radioddity

YUU Tl.lhe https://www.youtube.com/c/Radioddityradio
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